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DRV8899-Q1 EVM GUI User's Guide

This document is provided with the DRV8899-Q1 customer evaluation module (EVM) as a supplement to
the DRV8899-Q1 Automotive Stepper Motor Driver datasheet. This document only describes the
installation and usage of the DRV8899-Q1 EVM GUI. For additional details on hardware connections refer
to the DRV8899-Q1 EVM User's Guide.
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Overview
The DRV8899-Q1 customer EVM is a platform to support prototyping and evaluation for the DRV8899-Q1,
a medium-voltage dual H-bridge driver for stepper-driving applications. The DRV8899-Q1 drives a single
bipolar stepper with microstep settings ranging from full-stepping to 1/256 resolution with internallyregulated microstep levels. It provides a variety of programmable decay settings.
The EVM uses an MSP430™ microcontroller and a USB interface chip to manage communication from
the GUI software application installed on a PC computer with Windows®. The GUI sends serial commands
to the MSP430 to control the device signals, monitor faults, read and write SPI registers, and drive a
stepper motor by issuing the step commands at the desired rate. This document describes the software
and tools used to evaluate DRV8899-Q1 device for stepper motor driving on the DRV8899-Q1 EVM.

2

Hardware and Software Setup
The hardware (HW) and software (SW) tools that follow are required for the evaluation of DRV8899-Q1:
• DRV8899-Q1 EVM
• Stepper motor
• Voltage supply from 4.5 V to 45 V
This document only describes the installation and usage of the DRV8899-Q1 EVM GUI. For additional
details on hardware connections refer to the DRV8899-Q1 EVM User's Guide.
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GUI Application

3.1

Installation
Installation (For Desktop Version Only)
• Download the installable DRV8899-Q1_x.y.z_installer_win.zip file (x.y.z is the GUI revision number).
• Extract the zip file.
• Double click on the installer to install the GUI Application. During the first installation, the installer
prompts for installation of Cloud Agent. Install it.

3.2

Getting Started with DRV8899-Q1EVM GUI
The DRV8899-Q1 EVM GUI and DRV8899-Q1 EVM allows the user to configure various settings required
for stepper motor driving. The DRV8899-Q1 EVM GUI lets the user adjust the motor speed, control the
direction, control the step movement, configure various device settings, and monitor the device status.
Perform the following steps to begin using the GUI:
• Connect the stepper motor to the EVM.
• Plugin the micro-USB cable to the PC.
• Enable the motor power supply. For additional details on hardware connections refer to the DRV8899Q1 EVM User's Guide.
Click on DRV8899-Q1 EVM GUI shortcut either on the desktop or from the Start menu to run the GUI
application.

3.3

Use the DRV8899-Q1EVM GUI
•

2

The application opens with launch page shown in Figure 1.
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Figure 1. DRV8899-Q1 EVM GUI (Home Page)
•

The application will try to establish communication with the device connected. A message showing
‘Connected to Cloud Agent. Connecting to target…’ will be displayed in the hardware connection status
pane at the bottom of the screen. If the connection is successful, a ‘COMxx:9600 Connected to Target’
message appears as shown in Figure 2 below.

Figure 2. DRV8899-Q1 EVM GUI (Device Connection pane)
•
•
•

If the GUI fails to connect to the EVM, the hardware connection status pane will show the message
‘Hardware Not Connected.’
If the GUI is opened without connecting the EVM, the hardware connection status pane will show
‘Error: no serial ports found.’
If there are more than one DRV8899-Q1 EVM boards connected, the first matching device will be
connected automatically. In order to switch to another EVM,
– Click Options -> Serial Port. A serial port configuration popup is displayed as shown below in
Figure 3.
– Choose the appropriate port and baud rate.
– Click OK.
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Figure 3. Serial port configuration
•
•
3.3.1

Once the correct device is connected, the home page will show a message ‘Device Connected’ with a
green checkmark as shown in Figure 1.
Click on the ‘Stepper Motor’ button to open the stepper control page.
Stepper Control Page

The Stepper Control page (shown in Figure 4) includes various controls to sleep/wake the driver, control
the stepper motor, and configure various parameters such as slew rate, torque, full scale current, and so
forth. Hovering over the (?) icon to the right of a control displays a brief description about the control.

Figure 4. DRV8899-Q1 EVM GUI (Stepper Motor Control page)
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3.3.1.1

Stepper Control Modes

The GUI allows the user to control the stepper motion profile in two modes – Speed Mode and Step Mode.
To toggle between the modes, use the toggle button at the top of the screen.
3.3.1.1.1

Speed Mode

Speed Mode allows the user to spin the stepper motor continuously at a desired speed. The user
configures the starting speed, stopping speed, acceleration rate, and target speed. Stepper controls are
enabled only when 'Motor Driver' control is enabled for example, DRVOFF pin is set to low. The ‘Start
Steps’ button is enabled only when ‘Driver Outputs' control is enabled for example, DRVOFF pin is set to
low. When the ‘Start Steps’ button is clicked, the motor begins spinning at the starting speed and
accelerates to the target speed according to the configured acceleration rate. The acceleration profile in
the microcontroller firmware accepts the starting-speed and target-speed PPS values and calculates the
appropriate PWM clock period to create the stepping signal on the STEP pin. When the ‘Start steps’
button is clicked, the PWM timer generates steps at a rate specified by the 'Starting Speed' PPS
parameter. When ‘Stop Steps’ is clicked, the motor starts decelerating at the ‘Acceleration Rate’
configured to reach the stopping speed and eventually stop. The configuration is visualized by the
embedded graph shown on the GUI screen (Figure 5).
When accelerating or decelerating, the PPS signal is adjusted every 32 ms based on the integer value of
PPSPS / 32 ms. Acceleration rates must be between 1 and 65,535 PPSPS. The step rate increases by
the calculated value until the target speed is reached.
The starting speed must be less than or equal to the target speed. If the starting speed and target speed
are equal, the EVM firmware will not perform an acceleration routine. The stopping speed must also be
less than or equal to the target speed. The target speed is limited to a range between 1 and 65,535 PPS.
The 'Start Steps' command computes how frequently automatic speed updates are issued and a second
timer is used to change the speed according to the programmed acceleration rate profile. Once clicked,
the motor will begin spinning according to the parameters set in the GUI.
When the target speed PPS value is reached, the acceleration profile ends, and the motor continues
running at the target speed until the 'Stop Steps' button is clicked. When the stepper is commanded to
stop, the controller performs the same actions as it did while accelerating, but in reverse order, to
decelerate until the stopping speed PPS value is reached. At this point, the motor fully stops.

Figure 5. Controls available for Speed Mode

SLVUBR6A – October 2019 – Revised October 2019
Submit Documentation Feedback
Copyright © 2019, Texas Instruments Incorporated

DRV8899-Q1 EVM GUI User's Guide

5

GUI Application

3.3.1.1.2

www.ti.com

Step Mode

Step Mode allows the user to move the stepper motor a configured number of steps. Stepper controls are
enabled only when the 'Motor Driver' control is enabled for example, DRVOFF pin is set to low. When the
‘Start Steps’ button is clicked, the motor starts spinning at the starting speed and accelerates at the rate
configured. When the number of steps is reached, the motor stops.
The acceleration and deceleration profiles work similarly as before, except when the deceleration routine
starts and when the motor stops are a function of the 'Steps to Stop' and deceleration rate parameters.
The configuration can be visualized in the graph embedded in the GUI. If the "Reciprocate" button is
enabled, the stepper will travel the set number of steps, then reverse direction. It will do this continuously
until 'Stop Steps' is clicked. Figure 6 shows the controls available in Step Mode

Figure 6. Controls for Step Mode
The parameters from 'Speed Mode' are reused as well, and they operate the same as described in
Section 3.3.1.1.1. Two new parameters have been added to properly control the limited number of steps
actuation. These parameters are described as follows:
Number of Steps — This parameter is the number of steps that the controller will issue.
Steps to Stop — The controller is continuously monitoring the step being issued and when the current
step is equal to the 'Steps to Stop' parameter, a deceleration profile is issued. If the value of the
'Steps to Stop' parameter is larger than the number of steps, then the motor stops abruptly and
without undergoing a deceleration profile.
When a deceleration profile is issued, the controller decreases the speed until reaching the 'Stopping
Speed' value. If the 'Number of Steps' parameter is met before the deceleration profile is complete, then
the motor stops at the current speed. If the stopping speed is met before all the number of steps is issued,
then the motor rotates at the stopping speed value until all the steps are executed.
Ideally, the system should resemble the case in which the controller executes all the commanded steps at
a speed as close as possible to the stop speed. In the event this is not possible because of the particular
parameters that were selected, stopping the motor at a speed very close to the 'Stopping Speed'
parameter is often good enough to ensure good motion quality and application performance.
Figure 7 shows the three conditions possible when stopping and the action taken.
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1. Motor reaches stop speed at the stop speed.

2. Motor reaches stop speed before the stop speed is reached.

3. Motor runs out of steps before reaching stop speed.

Figure 7. Stop conditions
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Decay Mode
Decay refers to how the driving currents recirculate in H-bridge FETs during the off time. Using the GUI,
the user configure the decay mode. To configure,
• Click the Decay Mode button at the top center-right of the screen. A popup appears as shown below in
Figure 8.

Figure 8. DRV8899-Q1 EVM GUI (Decay mode)
•

3.3.3

Decay mode and appropriate TOFF values can be configured in the popup. The configurations can be
visualized in the graph shown. For information about the different decay modes, refer to the DRV8899Q1 Automotive Stepper Motor Driver datasheet.
Fault Monitoring

The fault monitor section at the right side of the screen allows the user to configure monitor the various
device faults. The LED staying green indicates ‘No Fault’. When the LED turns red, it indicates that a fault
has occurred. The user can also configure Fault reporting options by clicking the ‘Configure’ button.
3.3.4
•
•
•
•
•
•
•
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Register Map
Enabling the Motor Driver enables the Register page.
The page can be opened by clicking ‘Pencil’ icon from the side-bar menu
This page displays all the registers and their fields present on the DRV8899-Q1 device.
The page allows reading and writing any register, field, or bit.
To read a particular register, click on the register and click ‘Read Register’ button.
To read all the registers, click ‘Read All Registers’ button
To update the register values:
– Edit the ‘Value’ field directly to update a register’s hex value.
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•

– Change the field value from the field view at the right of the screen.
– Double click on any of the register bit to flip the bit (from 0 to 1 or vice versa).
By default, the write mode is Immediate which writes values to the registers immediately upon change.
Write mode can be changed to ‘Deferred’ which will write queue all changes and update the device
registers only when ‘Write Register’ or ‘Write All Registers’ is clicked.
Click on the question mark icon on any register or field to get in-place data sheet help.

Figure 9. DRV8899-Q1 EVM GUI (Registers Page)

3.3.5
1.
2.

3.
4.

3.3.6

Using Register Map
Configure desired motion profile in the GUI in Speed Mode. The default values will be acceptable for
immediate evaluation.
Configure device and motion profile settings as desired. The default values should be acceptable for
immediate evaluation. If motor torque is too high while evaluating, change the 'Full-Scale Current'
setting or 'Torque' setting to reduce it.
Click 'Start Steps' to begin spinning the motor.
Go to the Register Map page, and click 'CLR_FLT' in CTRL4 to clear any existing faults. Click 'READ
ALL REGISTERS' to refresh the register map.
Use the Side-Bar Menu

Use the side-bar menu in the left pane to navigate to the different pages at any time. Click on the
hamburger button in the top-left corner of the GUI to expand the side-bar menu. The following pages that
are displayed in the side-bar menu:
• Home
• Registers
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Stepper Motor Control
Menu bar Options

The following menus are available in the menu bar displayed at the top of the GUI as shown in Figure 10.

Figure 10. DRV8899-Q1 EVM GUI (Menu bar – Help Option)

3.3.7.1

File Menu

The File Menu has the following options:
• Program Device - The user can load the firmware (.out) file onto the device by clicking this option. For
the firmware load to work, MSP430 FET needs to be plugged into the J2 connector on the EVM board.
• Load/Save Registers – The user can save (and load) a particular configuration of the registers. This
saves time when the user need to reconfigure the registers after power cycle.
3.3.7.2

Options Menu

This menu provides the option to configure the serial port communication settings.
3.3.7.3

Help Menu

The Help Menu contains options to view Readme File and About Section. The about section displays the
installed software information including the application version.
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